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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking on an enterprise solution consisting of Avaya IP Office 11.0 to support
Clearcom SIP Trunking Service using TLS. These Application Notes update previously
published Application Notes with a newer software version of Avaya IP Office.

The test was performed to verify SIP trunk features including basic calls, call forward (all
calls, busy, no answer), call transfer (blind and consultative), conference, and voice mail. The
calls were placed to and from the public switched telephone network (PSTN) with various
Avaya endpoints.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the steps necessary for configuring Session Initiation Protocol
(SIP) Trunking service between Clearcom and an Avaya SIP-enabled enterprise solution using
Transport Layer Security (TLS).

In the configuration used during the testing, the Avaya SIP-enabled enterprise solution consists
of an Avaya IP Office Server Edition, two Avaya IP Office 500 V2 as expansion systems
running software release 11.0 (hereafter referred to as IP Office) and various Avaya endpoints,
listed in Section 4.

The Clearcom SIP Trunking Service referenced within these Application Notes is designed for
business customers. Customers using this service with the IP Office solution are able to place
and receive PSTN calls via a broadband wide area network (WAN) connection using the SIP
protocol. This converged network solution is an alternative to traditional PSTN trunks such as
analog and/or ISDN-PRI trunks. This approach generally results in lower cost for the enterprise.

The terms “service provider” or “Clearcom” will be used interchangeably throughout these
Application Notes.

2. General Test Approach and Test Results

The general test approach was to connect a simulated enterprise site to the Clearcom network via
the public Internet, as depicted in Figure 1, and exercise the features and functionalities listed in
Section 2.1.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.

Avaya recommends our customers implement Avaya solutions using appropriate security and
encryption capabilities enabled by our products. The testing referenced in this DevConnect
Application Note included the enablement of supported encryption capabilities in the Avaya
products. Readers should consult the appropriate Avaya product documentation for further
information regarding security and encryption capabilities supported by those Avaya products.

Support for these security and encryption capabilities in any non-Avaya solution component is
the responsibility of each individual vendor. Readers should consult the appropriate vendor-
supplied product documentation for more information regarding those products.
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For the compliance testing associated with this Application Note, TLS transport for Signaling
was used inside of the enterprise (private network side) and outside of the enterprise (public
network side). SRTP for media encryption was used inside of the enterprise (private network
side), RTP was used outside of the enterprise (public network side).

2.1. Interoperability Compliance Testing

To verify SIP trunk interoperability the following features and functionalities were exercised
during the interoperability compliance test:

SIP Trunk Registration (Dynamic Authentication).

Response to SIP OPTIONS queries.

Incoming PSTN calls to various Avaya endpoints, including SIP, H.323, Digital and
Analog telephones at the enterprise. All incoming calls from the PSTN were routed to the
enterprise across the SIP trunk from the service provider network.

Outgoing PSTN calls from Avaya endpoints, including SIP and H.323, Digital and
Analog telephones at the enterprise. All outgoing calls to the PSTN were routed from the
enterprise across the SIP trunk to the service provider network.

Incoming and outgoing PSTN calls to/from Avaya IX™ Workplace Client for Windows.
Dialing plans including local calls, outbound toll-free, etc.

Caller ID presentation.

Proper disconnect when the caller abandons the call before the call is answered.

Proper disconnect via normal call termination by the caller or the called parties.

Proper disconnect by the network for calls that are not answered (with coverage to
voicemail off).

Proper response to busy endpoints.

Proper response/error treatment when dialing invalid PSTN numbers.

Proper codec negotiation and two-way speech-path. Testing was performed with codecs:
G.729, G.711A and G.711MU, Clearcom preferred codec order.

Proper response to no matching codecs.

Proper early media transmissions.

Voicemail and DTMF tone support using RFC 2833 (leaving and retrieving voice mail
messages, etc.).

Outbound Toll-Free calls, interacting with IVR (Interactive VVoice Response systems).
Call Hold/Resume (long and short duration).

Call Forward (unconditional, busy, no answer).

Blind Call Transfers.

Consultative Call Transfers.

Station Conference.

Mobility twinning of incoming calls to mobile phones.

Items not supported or not tested included the following:

REFER message for call redirection was not tested for reasons noted under Section 2.2,
T.38 and G.711 fax pass-through were not tested for reasons noted under Section 2.2.
Inbound toll-free calls were not tested.

0, 0+10 digits, 911 Emergency and Local Directory Assistance calls were not tested.
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2.2. Test Results

Interoperability testing of Clearcom SIP Trunking Service was completed with successful results
for all test cases with the exception of the observations/limitations described below.

Call transfer to the PSTN using the SIP REFER method — Calls from the PSTN to the
enterprise that were transferred back to the PSTN network using the SIP REFER method
did not work properly. Calls that were blind transferred dropped. On attended transfers,
the REFER message was accepted by Clearcom with a 202 message, but the trunk
resources were not released. Due to these reasons, REFER was left disabled in the Avaya
IP Office for the tests (refer to Sections 5.4.2). With REFER disabled, blind and attended
call transfers to the PSTN were allowed to complete, with the caveat that the IP Office
was not released from the call path, and two trunks circuits remained seized for the
duration of the call.

Outbound Calling Party Number (CPN) Block — Clearcom did not allow outbound
calls with privacy enabled. When the IP Office user activated “Withhold Number” to
enable user privacy on outbound calls, IP Office sent “anonymous” in the “From” header,
while the caller information was still being sent in the “P-Asserted-Identity”” header.
Clearcom responded with a “403 PSTN calls are forbidden” message and the call was
rejected.

Caller ID on outbound calls — On calls originating from IP Office extensions to PSTN
telephones, the caller ID number displayed on the PSTN endpoint was always of the main
(pilot) DID number assigned by Clearcom to the SIP trunk, not of the specific DID
number assigned to the IP Office extension originating the call. This includes calls to
“twinned” mobile phones and calls that were forwarded or transferred back on the SIP
trunk to the PSTN. This may be a requirement of the Clearcom service for all outbound
calls, it is listed here simply as an observation.

Fax support — Fax calls using the T.38 protocol failed during the compliance test. G.711
pass-through fax was also tested, but it behaved unreliably. The issue related to G.711
pass-through fax failing during the compliance test may be related to the unpredictability
of G.711 pass-through techniques, which only works well on networks with very few
hops and with limited end-to-end delay. The issue related to T.38 fax calls failing is
related to the PSTN carriers being used in Mexico, not all PSTN carriers in Mexico
support T.38. This issue could be solved by Clearcom selecting and routing T.38 fax
traffic via PSTN carriers that support T.38.

SIP OPTION Messages — During the compliance test Clearcom did not send SIP
OPTION messages to IP Office, IP Office did send SIP OPTION messages to Clearcom,
this was sufficient to keep the SIP trunk up in-service.
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2.3. Support
For support on Clearcom systems visit the corporate Web page at: http://www.clearcom.mx/

Avaya customers may obtain documentation and support for Avaya products by visiting
http://support.avaya.com. Alternatively, in the United States, (866) GO-AVAYA (866-462-8292)
provides access to overall sales and service support menus.
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3. Reference Configuration

Figure 1 illustrates the test configuration used for the DevConnect compliance testing. The test
configuration simulates an enterprise site with an Avaya SIP-enabled enterprise solution
connected to the Clearcom SIP Trunking Service through the public Internet.

The Avaya components used to create the simulated enterprise customer site includes:
e [P Office Server Edition running in VMware environment.
— Avaya IP Office Voicemail Pro.

Two Avaya IP Office 500 V2 as expansion systems.

Avaya 96x1 Series IP Deskphones (H.323).

Avaya J179 IP Deskphones (H.323).

Avaya 1100 Series IP Deskphones (SIP).

Avaya J129 IP Deskphones (SIP).

e Avaya 1400 Series Digital Deskphones.

e Analog Deskphones.

e Avaya IX™ Workplace Client for Windows (SIP).

Avaya IP Office provides the voice communications services for the enterprise. In the reference
configuration, Avaya IP Office runs on the Avaya IP Office Server Edition platform. Note that
this solution is extensible to deployments using the standalone IP500 V2 platform as well.

In the sample configuration, the Primary server runs the Avaya IP Office Server Edition Linux
software. Avaya Voicemail Pro runs as a service on the Primary Server. The LAN1 port of the
Primary Server is connected to the enterprise LAN. The LAN2 port was used to connect to the
public network.

The Expansion Systems (IP500 V2) were used for the support of digital, analog and additional IP
stations. The Avaya IP Office 500 V2s are equipped with analog and digital extension expansion
modules, as well as a VCM64 (Voice Compression Module). The LAN1 port of the Avaya IP
Office IP500 V2 expansion systems was connected to the enterprise LAN, the LAN2 port was
not used.

IP endpoints at the enterprise include 96x1 Series IP Deskphones (with H.323 firmware), Avaya
1100 and J100 Series IP Deskphones (with SIP firmware), Avaya 1400 Series Digital
Deskphones, Analog Deskphones and Avaya IX™ Workplace Client for Windows (SIP). Some
IP endpoints were registered to the Primary Server while others were registered to the Expansion
Systems. Avaya 1400 Series Digital Deskphones and analog telephones are connected to media
modules on the Expansion Systems. The site also has a Windows PC running Avaya IP Office
Manager to configure and administer the system. Mobile Twinning is configured for some of the
IP Office users so that calls to these user’s extensions will also ring and can be answered at the
configured mobile phones.

The transport protocols on the SIP trunk between IP Office and Clearcom, across the public
Internet, is SIP over TLS for signaling and RTP for media. The transport protocol between
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Avaya components inside the enterprise private IP network (LAN) is SIP over TLS for signaling
and SRTP for media.

For the compliance test, users dialed a short code of 9 + N digits to make calls across the SIP
trunk to the Clearcom network. The short code 9 was stripped off by Avaya IP Office but the
remaining N digits were sent unaltered to Clearcom network.

In an actual customer configuration, the enterprise site may include additional network
components between the service provider and the IP Office system, such as a session border
controller or data firewall. A complete discussion of the configuration of these devices is beyond
the scope of these Application Notes. However, it should be noted that all SIP and RTP traffic
between the service provider and the IP Office system must be allowed to pass through these
devices.

For confidentiality and privacy purposes, public IP addresses, domain names, and routable DID
numbers used during the compliance testing have been masked.

Service Provider

| SIP (TLSIRTP)

Simulated Enterprise
Domain: avaya.lab.com
DIDs: 525528815941 - 5842

Figure 1: Avaya Interoperability Test Lab Configuration
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4. Equipment and Software Validated

The following equipment and software were used for the sample configuration provided:

Equipment/Software \ Release/Version
Avaya

Avaya IP Office Server Edition (Primary Server) 11.0.4.1.0 Build 11

e Avaya IP Office Voicemail Pro 11.0.4.1.0 Build 2
Avaya IP Office IP500 V2 (Expansion Systems) 11.0.4.1.0 Build 11
Avaya IP Office Manager 11.0.4.1.0 Build 11
Avaya 96x1 Series IP Deskphones (H.323) 6.8002
Avaya J179 IP Telephone (H.323) 6.8002
Avaya 1140E IP Deskphones (SIP) SIP1140e Ver. 04.04.23.00
Avaya J129 IP Deskphones (SIP) 4.0.3.0.10
Avaya 1408 Digital Telephone 48.02
Avaya IX™ Workplace Client for Windows 3.7.6.10.1
(SIP)
Analog Telephone

Clearcom

OpenSIPS Softswitch 1.9
OpenSIPS Session Border Controller 1.9

Note: Compliance Testing is applicable when the tested solution is deployed with a standalone
IP Office 500 V2 and also when deployed with all configurations of IP Office Server Edition. IP
Office Server Edition requires an Expansion IP Office 500 V2 to support analog or digital
endpoints.
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5. Avaya IP Office Primary Server Configuration

Avaya IP Office is configured through the Avaya IP Office Manager application. From the PC
running the IP Office Manager application, select Start - Programs - IP Office > Manager
to launch the Manager application. Log in using the appropriate credentials.

£ Select IP Office [= (= |[=]
MNarme IP Address Type Version Edition
Server Edition 11.0
IPOSE-Primary 1064101127 IPO-Linux-PC 11.04.1.0build11 Server (Prirmary)
Configuration Service User Login
IP Office: IPOSE-Primary (Primary System - IPO-Linux-PC)
Service User Name
Service User Password
l Cancel l [ Help
TCP Discovery Progress | J
Unit/Broadcast Address Open with Server Edition Manager
1064101127 - oK || Conce
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On Server Edition systems, the Solution View screen will appear, similar to the one shown
below. All the Avaya IP Office configurable components are shown in the left pane, known as
the Navigation Pane. Clicking the “plus” sign next to the Primary server system name, e.g.,
IPOSE-Primary, on the navigation pane will expand the menu on this server.

Configuration || = Server Edition

@K BOOTP ) Summary Open...
# Operator (3)

E-f  User(56)

- Group(2)

-
-8 Short Code(48) = Hardware Installed i System Status
-4 Directory(0) Gontrol Unit: IPO-LinuxRC E Voicemail Administration
7 Time Profile(0) Secondary Server: 10.64.70.60 -
#m Account Code(0) Expansion Systems: 192.168.128.165 @ Resiliency Administration
E-§ User Rights(@) System |dentification: 1bed5074dci7 4cdifife44cabdB466ae06238c710 X

&5 Location(l)

- . = System Settings & On-boarding
“5 [POSE-Primary IP Address: 10.64.101.127

7 [P500V2-One

Sub-Net Mask 255,265 255.0
% IPS00V2-Two up-etias

% 1pOfice Web Manager
System Locale: United States (US English)

Hel

System Location: 3: Thornton, CO @ mee

Device ID: NONE 5

Number of Extensions on System: & 7% SetAll Nodes to Select

;\‘ Set All Nodes License Source

Add...
% Secondary Server

7% Expansion System

Description Mame Address Primary Link Secondary Link Users Configured Extensions Configured
Solution 56 78
% Primary Server IPOSE-Primary 10.64.101.127 Bothway 6 6
® Secondary Server  [P500V2-Two 10.64.70.60 Bothway 25 43
® Expansion System IP500V2-One  192.168.128.165 Bothway MNone 25 24
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In the screens presented in the following sections, the View menu was configured to show the
Navigation pane on the left side and the Details pane on the right side. These panes will be
referenced throughout the rest of this document.

Standard feature configurations that are not directly related to the interfacing with the service
provider are assumed to be already in place, and they are not part of these Application Notes.

5.1. Licensing

The configuration and features described in these Application Notes require the IP Office system
to be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity,
contact an authorized Avaya sales representative.

In the reference configuration, IPOSE-Primary was used as the system name of the Primary
Server and IP500V2-One and IP500V2-Two were used as the system names of the Expansion
Systems. All navigation described in the following sections (e.g., License) appears as submenus
underneath the system name in the Navigation Pane.

Navigate to License in the Navigation Pane. In the Details Pane verify that the License Status
for SIP Trunk Channels is Valid and that the number of Instances is sufficient to support the
number of channels provisioned for the SIP trunk.

Configuration ‘
@-& BOOTP @) [ License | Remote Server
-4 Operator (3)
El-% Solution License Mode License Normal
g% g:::;(s?z]) Licensed Version 11.0
(-8 Short Code(48) PLDS Host ID
----- @ Directory(0) . .
f:l"'\ Time Profile(0) PLDS File Status ~ Valid
----- | Account Code(l)
Dm&'i User Rights(Q) Feature Instances Status Expiration Date Source
(58 Location(l)
E_j...!-.,_,‘ Additional Voicemail Pro Ports 152 Valid Newver PLDS Nodal
[H-*%23 Systern (1) VMPro Recordings Administrators 1 Valid MNever PLDS Nodal
-1 Line (3) Essential Edition Additional Voice.. 4 Obsolete Never PLDS Nodal
&> Control Unit (3) VMPro TTS (Generic) 40 Obsolete Never PLDS Nodal
gf Ef::r”;?" (©) Teleworker 384 Obsolete Never PLDS Nodal
..... ﬁ Group (0) Mobile Worker 384 Obsolete MNever PLDS Nodal
8% Short Code (2) Office Worker 384 Valid MNewver PLDS Modal
""" @B Service (0) Mvaya Softphone Licence 100 Valid Never PLDS Nodal
& Incoming Call Route (2) VMPro TTS (Scansoft) 40 Obsolete Never PLDS Nodal
E?::' I Route & VMPro TTS Professional 40 Valid Never PLDS Nodal
G- ARS (1) IPSec Tunnelling 1 Obsolete MNewver PLDS Modal
(-85 Location (1) Power User 384 Valid Mever PLDS Modal
----- @ Authorization Code (0) Avaya IP endpoints 384 Valid Newver PLDS Nodal
(-7 IP500V2-One IP500 Voice Networking Channels 32 Obsolete Never PLDS Nodal
-5 IP500V2-Two [5P Trunk Channels 128 Valid Never PLDS Nodall
IP500 Universal PRI (Additional cha... 100 Obsolete Mever PLDS Modal
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On Server Edition systems, the numbers of licenses to be assigned to the specific Server or
Expansion Systems are reserved from the total pool of licenses present on the license server. On
the screen below, 10 SIP Trunk Sessions licenses were reserved to be used by the Primary

Server.

Configuration

=- & BOOTP (8)

w Operator (3)

-9 Solution

B-f  User(S8)

-4 Group(2)

[-BX Short Code(d8)
----- s Directory(0)
£ Time Profile(0)
----- 8 Account Code(0)
#-§5 User Rights(3)
B8 Location
[—:I---"-“.qJ
(-5 System (1)
#-T9 Line (3)
[H-<2» Control Unit (9)
[

[

t--4 Extension (6)

]a User (7)

4§ Group (0)

[+-'8% Short Code (2)

@ Service (0)

-3 Incoming Call Route (2)
(-l IP Route (3)

(- ARS (1)

(-5 Location (1)

m Authorization Code (0)
[+-557 IPS00V2-0ne

%5 IPS00V2-Two

| Licensel Remote Server |

Remote Server Configuration

License Source ’Local

License Server IP Address 127

Reserved Licenses

SIP Trunk Sessions 10 |

Server Edition

Avaya IP Endpoints
3rd Party IP Endpoints
Receptionist

Office Worker

Power User

Avaya Softphone

Web Collaboration
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5.2. System Settings

Configure the necessary system settings. The LAN2 tab settings correspond to the IP Office
WAN port (public network side) and the LAN1 tab settings correspond to the LAN port (private
network side).

Note: In the compliance test, the LAN1 interface was used to connect the Avaya IP Office to the
enterprise site IP network (private network). The LAN1 interface configuration is not directly
relevant to the interface with the Clearcom SIP Trunking Service, and therefore is not described
in these Application Notes.

5.2.1. System — LAN2 Tab

In the sample configuration, the LANZ interface is used for the SIP trunk connection to
Clearcom.

5.2.1.1 LAN2 - LAN Settings Tab

To view or configure the LAN2 IP address and subnet mask, select the LAN2-> LAN Settings
tab, and enter the information as needed, according to the customer network requirements:
e IP Address: 10.10.80.55 was used in the reference configuration, this is the public IP
address assigned to IP Office.
e IP Mask: 255.255.255.128 was used in the reference configuration.

e Other parameters on this screen are set to the defaults.
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Configuration 7 IPOSE-Primary*
=-#& BOOTP (8) | System | LANL I LANZ | DMS | Voicemail | Telephony | Directory Services | System Events |
Operator (3)

é---*‘ﬂ Solution

E-§  User(56)

- Group(2)

[-@% Short Code(48)

28 Directory(D)

-1 Time Profile(0)

-l Account Code(0)
G-§5 User Rights(9)

(-8 Location(l)
[=-5=2|IPOSE-Prirmary

= = System (1)

-7 POSE-Primary
T4 Line (3)

-2 Control Unit (3)
-4 Extension (6)
B User(7)

----- % Group (0)

[+-8% Short Code (2)

----- @ Service (0]

43 Incoming Call Route (2)
=il IP Route (3)

----- = License (33)

- ARS (1)

[ Location (1)

----- ﬂ Authorization Code (0]
[-%57 IPS00V2-One

[ IPS00V2-Two

LAN Settings | VioIP | Network Topolog‘y|
IP Address o . 1w . 8 . 55
IP Mask 255 . 255 . 255 . 128

-

MNumber Of DHCP IP Addresses 200
DHCP Mode

) Server ) Client @ Disabled
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5.2.1.2 LAN2 VoIP Tab

e Select the LAN2 - VolIP tab in the Details Pane. Check the SIP Trunks Enable box to
allow the configuration of SIP trunks. Since no SIP endpoints are to register on this
interface, leave the SIP Registrar Enable box unchecked.

Configuration

7 IPOSE-Primary*

=& BOOTP (8)
[-¢% Operator (3)
=423 Solution
E-@  User(56)
(-8 Group(2)
(8% Short Code(48)
-8 Directory(0)
£ Time Profile(0)
-l Account Code(0)
(-fg User Rights(d)
(-5 Location(l)

[_]...x.?;
=E

..... -

=7 IPOSE-Primary

H-T4 Line (3)

H-<2 Control Unit (9)
|- Extension (6)
H-§  User (7)

..... a Group (0)
(-8 Short Code (2)
----- @ Service (0)

frn e W W

(-Jiill IP Route (3)
----- % License (33)
- ARS (1)

(-8 Location (1)

(-2 IP500V2-One
-2 IP500V2-Two

(-4 Incoming Call Route (2)

----- m Authorization Code (0)

| System | LANL I LANZ | DNS | Voicemail | Telephony | Directory Services | Systern Events | SMTP | SMDR | VoIP | Contact Center

| LAN Settingsl VolP | Metwork Topology|

[] H323 Gatekeeper Enable

Auto-create Extension Auto-create User H.323 Rernote Extension Enable

H.323 Signaling over TLS |Disabled Remote Call Signaling Port {1720

SIP Trunks Enable

[C] SIP Registrar Enable

Auto-create Extension/User SIP Remote Extension Enable s | Block blacklist only

upp JDP Port 5060 2 Remote UDP Port 5060
Protoco TCP TCP Port  |5060 : Remote TCP Port  |5060
TLS TLS Part  |5061 2 Remote TLS Port  |5061

T 10
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Scroll down the page:
e Verify the RTP Port Number Range. Based on this setting, Avaya IP Office will
request RTP media to be sent to a UDP port in the configurable range for calls using
LAN2. The Minimum and Maximum port numbers were kept at their default values in
the reference configuration.

e In the Keepalives section, set the Scope to RTP-RTCP. Set the Periodic timeout to 30
and the Initial keepalives parameter to Enabled. This is done to prevent possible issues
with network firewalls closing idle RTP channels.

¢ Inthe DiffServ Settings section, IP Office can be configured to mark the Differentiated
Services Code Point (DSCP) in the IP Header with specific values to support Quality of
Services (QoS) policies for both signaling and media. The DSCP field is the value used
for media, while the SIG DSCP is the value used for signaling. These settings should be
set according to the customer’s QoS policies in place. The default values used during the
compliance test are shown.

e Click OK to commit (not shown).

7

| system [ Lana | LAN2 | DNS | Voicemail | Telephony | Directory Services | System Events | sMTP | SMDR | voIP

Configuration | IPOSE-Primary*

BOOTP (8)

| LAN Settingsl VolP | Network Topology|

B-@  User(36) TLS 5061 5061
(-5 Group(2)
9% Short Code(48) 10
----- = Directory(0)
-7 Time Profile(0)
----- B Account Code(0)
(-5 User Rights(d) RTP
-5 | nrahn”m Port Number Range
Minimum 40750 > Maximum 50750 5
= IPOSE-Primary
-4 Line (3)
- Contrgl Unit (3) Port Number Range (NAT)
-8 Extension (6)
D...a User (7) Minimum 40750 =
..... u Group (0)
(-8% Short Code (2)
""" B service (0) Enable RTCP Monitoring on Port 5005
] 9
EJ---@ Incoming Call Route (2)
(-Jiilll IP Route (3) RTCP collector IP address for phones 0
----- % License (33) Keenalves
©- ¢ ARS (1) P
&% Location (1) Scope [RTP-RTCP ~| Periodic timeout 30
----- ﬁ Authorization Code (0)
-3 IP500V2-One Initial keepalives ’Enabled ']
[H-*452 IP500V2-Two
DiffServ Settings

B3 + DSCP{Hex) (B8 + Video DSCP (Hex) FC + DSCP Mask (Hex) (88 + SIG DSCP (Hex)

46 | Dscp 46 2| Video DSCP 63 2| DSCP Mask 34 = siG Dscp

DHCP Settings

Primary Site Specific Option Number (S50N) 176 5

Secondary Site Specific Option Number (S50N) 242 5

wan

1100 Voice VLAN Site Specific Option Mumber (SSON) 232 5

1100 Voice VLAN IDs
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5.2.1.3 LAN2 - Network Topology Tab

On the LAN2 Network Topology tab in the Details pane, set the following:

e Select the Firewall/NAT Type from the pull-down menu to Open Internet. With this
configuration, the STUN Server IP Address and STUN Port are not used.

e Set Binding Refresh Time (seconds) to 180. This value is used to determine the
frequency at which Avaya IP Office will send SIP OPTIONS messages to the service

provider.

e Set Public Port to TLS 5061.
e Default values were used for all other parameters.
e Click the OK button (not shown).

@5 Directory(0)
Time Profile(0)
Account Code(0)

+-§i5 User Rights(9)

+l§ Location(1)

—I-+%9| IPOSE-Primary
System (1)

=7 |IPOSE-Primary
414 Line (3]

~“2r Control Unit (9)
t-48 Extension (6)

User (7}

+n IP Route (3)

% License (33)

- ARS (1)

+l§4_? Location (1)

498 Authorization Code (0)
t-437 IP500V2-One

+-459 |P500V2-Two

Firewall/MNAT Type Open Internet ~
Binding Refresh Time (sec) 180 =

Public IP Address 0 0 0 0

Public Port

upp 5060

TCP 5060

Al |[ale] ([4]e

TLS 5061

[ Run STUN on startup

Configuration | = IPOSE-Primary
+’$ gOOTS (233) System  LAN1 DNS Voicemail Telephony Directory Services  System Events  SMTP SMDR VelP Contact Center
i Operator
-5 Selution LAM Settings VolP | Metwork Topolagy
#-§  User(56) :
+1ﬂ Group(2) MNetwork Topology Discovery
+-@% Short Code(48) STUN Server Address | 3478 =

Cancel
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5.2.2. System - DNS Tab

Public DNS servers IP addresses are required to be configured; IP Office will retrieve Clearcom
Proxy IP Addresses via public DNS queries using Clearcom ISTP Domain Name configured
under in Section 5.4.2. To access the System DNS settings, navigate to the DNS tab in the
Details pane, configure the following parameters:

Under DNS Server IP Address and Backup DNS Server IP Address enter the primary and

[
backup public DNS servers IP addresses. These IP addresses should be provided by
Clearcom.
e Click OK to commit (not shown).
Configuration = IPOSE-Primary

£

=K BOOTP (8)

-¢% Operator (3)
[=-%%7 Solution

E-§  User(56)
-8 Group(2)
[-BX Short Code(48)
----- a5 Directory(0)

----- £ Time Profile(0)
----- 0 Account Code(D)
E-§i5 User Rights(g)
B~ Location(l)
=559 IPOSE-Primary

B %27 Systemn (1)

-ty IPOSE-Primary
-T4 Line (3)

-2z Control Unit (9)
-4y Extension (6)

: a Uzer (7)

ﬂ' Group (0)

[-8% Short Code (2)
@ Service (0}

@ Incoming Call Route (
n IP Route (3)

% License (33)

B ARS (1)

ﬁ Location (1)

ﬁ Authonzation Code (0
H-427 IP500V2-One

£

-3 IPS00V2-Two

| System | LaNL | LAN2 | DNS

Voicemail | Telephony | Directory Services | System Events |

DMS Server IP Address

Backup DMS Server IP Address

8

75

8

75

8

75

8

75

DMS Domain
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5.2.3. Telephony Tab

To access the System Telephony settings, navigate to the Telephony = Telephony tab in the
Details pane, configure the following parameters:

e Choose the Companding Law typical for the enterprise location; U-Law was used for
the compliance test.

e Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding and
call transfer to the PSTN. If for security reasons incoming calls should not be allowed to
transfer back to the PSTN then leave this setting checked.

e All other parameters should be set to default or according to customer requirements.

e Click OK to commit (not shown).

Configuration |E IPOSE-Primary*
@-R BOOTP () System | LANL [LAN2 [ DNS [ Voicemail | Telephony | Directory Services | System Events [ SMTP | SMDR [Vol? | Contact Center | Avaya Cloud Services
B-4% Operator (3)
El-*57 Solution Telephany | Park & Pagel Tones & Mus\cl Ring Tones | M | Call Log |TUI |
i-§  User(56)
5§ Group(2) Dial Delay Time (sec) 4 2 Companding Law
£--@% Short Code(48) — Switch Line
@5 Directory(0) Dial Delay Count 0
-1 Time Profile(0) : 5 i
; Account Code(0) Default Mo Answer Time (sec) 13 = ® U-Law @ U-LawLine
3 .ai User Rights(3) Hold Timeout (sec) 0
-8 Location(1) = A-L 7 A-Law Li
iy X ) [ &) -Law l'#) -Law Line
=I5\ IPOSE-Primary Park Timeout (sec) 300
5= System (1)
&7 IPOSE-Primary Ring Delay (sec) 5 5
-7 Line (3) [ DSS Status
~“2 Control Unit (3) Call Priority Promotion Time (sec) |Disabled =
& Extension (6) [ Auto Hold
&k Group (0) Default Name Priori
g Shart Code (2) ty v Show Account Code
D Incoming Call Route () Media Connection Preservation Enabled ] Inhibit OFf-Switch Forward/Transfer
E LI(;‘::(;J] Phone Failback dusinmalic [T Restrict Network Interconnect
X Login Code C lexi
K ARS U_'] ogin Code Complaxity Include location specific information
-&@ Location ] Enforcement
%% Authorization Code (0) = Drop External Only Impromptu Conference
b--%27 IPS00V2-One Minirnum length |6 =
o5 IPS00V2-Two Complexity [C] Visually Differentiate External Call
High Quality Conferencing
RTCP Collector Configuration Directory Overrides Barring
Send RTCP t RTCP Collect:
[ Sen ean oflector [ Advertise Callee State To Internal Callers
0 g g g [[] Internal Ring on Transfer
5005
5
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5.2.4. VoIP Tab

Navigate to the VoIP tab in the Details pane to view or change the system codecs and VolIP
security settings.

5.2.4.1 VolIP - VolP Tab

Select the VolP - VolIP tab, configure the following parameters:

e The RFC2833 Default Payload field allows for the manual configuration of the payload
type used on SIP calls that are initiated by the IP Office. The default value 101 was used.

e For codec selection, select the codecs and codec order of preference on the right, under
the Selected column. The Default Codec Selection area enables the codec preference
order to be configured on a system-wide basis. The buttons between the two lists can be
used to move codecs between the Unused and Selected lists, and to change the order of
the codecs in the Selected codecs list. By default, all IP lines and phones (SIP and H.323)
will use the system default codec selection shown here, unless configured otherwise for a
specific line or extension. The example below shows the codecs used for IP phones (SIP
and H.323), the system’s default codecs and order were used.

e Click OK to commit (not shown).

Configuration |Ei IPOSE-Primary*

-& BOOTP (8)
(v« Operator (3)
= Solution VolP IVOIP Security | Access Control Listsl
H-@  User(56)

H-iaf Group(2) Ignore DTMF Mismatch For Phones 0
H-@% Short Code(48)

----- a4 Directory(0)
£ Time Profile(0)
..... 8w Account Code(0) | RFC2833 Default Payload 101

-y User Right:
[]--E'T;t Los:;tinl:ugntlz(gj Awailable Codecs Default Codec Selection

[ system [LaNt [ LaN2 [ DNS | voicemail | Telephony [ Directory Services | System Events | smTp [ smor [ vale ||

i

-7

Allow Direct Media Within NAT Location [

3

4

=-2f IPOSE-Primary Unused Selected

=l % System (1) G711 ULAW 64K P G.711 ULAW 64K
52 IPOSE-Primary G711 ALAW B4K G711 ALAW 64K
T4 Tine (3] [ G722 64K 5.729(a) BK C5-ACELP
(-2 Control Unit (9) G.729(3) 8K CS-ACELP

(-4 Extension (6)

B User (7)

..... u Group 0)

&-@% Short Code (2)

----- @ Service (0)

&-§) Incoming Call Route (2)
(-l IP Route (3)

----- % License (33)

- ARS (1)

-&& Location (1)

----- “ Authorization Code (0)
[#-439 IP500V2-One

[#-%3p IP500V2-Two

B

Note: The codec selections defined under this section (VolP — VolP Tab) are the codecs selected
for the IP phones/extensions. The codec selections defined under Section 5.4.6 (SIP Line — VoIP
tab) are the codecs selected for the SIP Line (Trunk).
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5.2.4.2 VolP - VolP Security Tab
Secure Real-Time Transport Protocol (SRTP) refers to the application of additional encryption

and or authentication to VolIP calls (SIP and H.323). SRTP can be applied between telephones,
between ends of an IP trunk or in various other combinations.

Configuring the use of SRTP at the system level is done on the VoIP Security tab using the
Media Security setting. The options are:

e Disabled (default).

e Preferred.

e Enforced.

When enabling SRTP on the system, the recommended setting is Preferred. In this scenario, IP
Office uses SRTP if supported by the far-end, otherwise uses RTP. If the Enforced setting is
used, and SRTP is not supported by the far-end, the call is not established.

To configure the use of SRTP, select the VolP - VolP Security tab on the Details pane.

e Set the Media Security drop-down menu to Preferred to have IP Office attempt use
encrypted RTP for devices that support it and fall back to RTP for devices that do not
support encryption.

e Verify Strict SIPS is not checked.

e Under Media Security Options, select RTP for the Encryptions and Authentication
fields.

e Under Crypto Suites, select SRTP_AES CM_128 SHA1 80.

e Click OK to commit (not shown).
Configuration |Ei IPOSE-Primary*
': gomr (8(33] | system | LANL | LAN2 | DNS | Voicemail | Telephony | Directory Services | System Events [ SMTP | SMDR | VoIP [I
-4 perator T -
=% Solution WVoIP VolIP Security IAccas Control Lisisl
B-§  User(56)
E]---ﬂ Group(2) Default Bxtension Password
[+-8% Short Code(48)
----- s Directory(0) Confirm Default Extension Password
-£7 Time Profile(0)
----- m Account Code(D)
[j---a.i User Rights(3) Media Security | Preferred '] [T Strict SIPS
[+ Location(1) . . .
Media 5 Opt
-4 IPOSE-Primary edia Security Options
=1 System (1) Encryptions RTP
&% IPOSE-Primary
-7 Line (@) [ Rrce
-2 Contral Unit (3) Authentication RTP
[--48 Extension (6)
B-§ User@) RTCP
..... % Group (0) Replay Protection
[#-8% Short Code (2)
..... @ Service (0) SRTP Window Size 64
-4 Incoming Call Route (2) Crypto Suites
-l IP Route (3)
----- %, License (33) SRTP_AES_CM_128_SHAL 80
- ARS (1) [C] SRTP_AES_CM_128_SHA1 32
-8 Location (1)
----- m Authorization Code (0)
(-3 IPS00V2-One
-3 IPS00V2-Two
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5.3. IP Route

Create an IP route to specify the IP address of the gateway or router where the IP Office needs to
send the packets in order to route calls to Clearcom network.

Navigate to IP Route, right-click on IP Route and select New. The values used during the
compliance test are shown below:
e Set the IP Address and IP Mask to 0.0.0.0 to make this the default route.
e Set Gateway IP Address to the IP address of the gateway/router used to route calls to the
public network, e.g., 10.10.80.1.
e Set Destination to LAN2 from the pull-down menu.
e Click OK to commit (not shown).

Configuration ‘ = 0.0.0.0

...g BOOTP (8) IP Route

[H-i# Operator (3)

=45 Solution IP Address g ’ ° -
G-f  User(56)
E]---ﬂ Group(2)
9% Short Code(48)
----- @ Directory(0)
£ Time Profile(0) Destination LANZ
----- 8 Account Code(])
-G User Rights(g) Metric g
- Location(1)

[H-%=3 System (1)
H-TF Line (3)

-2 Control Unit (9)
£

£

IP Mask 0 0 0 0

Gateway IP Address 10 10 80 1

-4 Extension (6)

H-§  User (@)

..... a Group (0)

(-8 Short Code (2)

----- @ Service (0)

(43 Incoming Call Route (2)

E—]n IP Route (3)
= 1 10.00.0

----- % License (33)

B¢ ARS (1)

(- Location (1)

----- ﬁ Authorization Code (0)
[#-%=3 IP500V2-One

(%39 IPS00V2-Two
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5.4. SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and Clearcom.
The recommended method for configuring a SIP Line is to use the template associated with these
Application Notes. The template is an .xml file that can be used by IP Office Manager to create a
SIP Line. Follow the steps in Sections 5.4.1 to create the SIP Line from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses

e SIP Credentials (if applicable)

e SIP URI entries

e Setting of the Use Network Topology Info field on the Transport tab

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary,
after the SIP Line is created via the template. The resulting SIP Line data can be verified against
the manual configuration shown in Section 5.4.2 to 5.4.7.

Alternatively, a SIP Line can be created manually. To do so, right-click on Line in the
Navigation pane and select New > SIP Line. Then, follow the steps outlined in Sections 5.4.2
to 5.4.7.

5.4.1. Creating a SIP Trunk from an XML Template

DevConnect generated SIP Line templates are always exported in an XML format. These XML
templates do not include sensitive customer specific information and are therefore suitable for
distribution. The XML format templates can be used to create SIP trunks on both IP Office
Standard Edition (500 VV2) and IP Office Server Edition systems. Alternatively, binary templates
may be generated. However, binary templates include all the configuration parameters of the
Trunk, including sensitive customer specific information. Therefore, binary templates should
only be used for cloning trunks within a specific customer’s environment.

Copy a previously created template file to a location (e.g., \Temp) on the same computer where
IP Office Manager is installed.

HG; Reviewed: Solution & Interoperability Test Lab Application Notes 23 of 56
SPOC 6/24/2020 ©2020 Avaya Inc. All Rights Reserved. CTLSIPO1104



To create the SIP Trunk from the template, from the Primary server (IPOSE-Primary), right-
click on Line in the Navigation Pane, then navigate to New > New from Template->Open
from file.

3
H
H

H
3

=- & BOOTP (8)
#-¢% Operator (3)
=% Solution

SIP Line |Transport| Call Details|VolP  |SIP Credentials|SIP Advanced | En

@ Incoming Call Route (2]
G-l IP Route (3)
R License (33)

F- ARS (1)

5@ Location (1)

------ a Authorization Code (0)
[#-%=p IP500V2-One

[#-5=p IPS00V2-Twao

Uescription

Line Murnber 17 =
- User(56)
:Iﬂ Group(2) ITSP Domain Mame
-8 Short Code(48)
----- s [Directory(0) Local Domain Mame 10.10.80.55
----- 1% Time Profile(0)
..... B Account CDdEI:U:] LRI T}pr ISIP LRI
;% E::;:;théifg] Location ’CIoud
-9 IPOSE-H &
...sh 1_1 Mew 3
= .
t@_ | & Cut Ctrl+X
W, |53 Copy Ctrl+C ;
™ ] L Paste Ctrl+V
G-y Extel £ Delete Ctrl+Del
---i Use| o+ Validate
2 ;:DD| MNew from Template » [
- Export as Ternplate i
-y Seny p p

Open from file
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Navigate to the directory on the local machine where the template was copied and select the
template.

I open X
<« A <« TR10349 - Clearcom IP Office 11.0.4 using TLS » Template ~ O Search Template
Organize v New folder ==~ [ 0
Avaya on-X Con ™ MName . Date modified Type Size
Avaya SBCET.2. | [ CTLSIPOT104aml 5/4/2020 3:00 PM XML Document 9KB
Avaya SBCE .01
Clearcom
TRAD immmm &7
File name: | v| Template Files (*xml) -

After the import is complete, a final import status pop-up window will open stating success or
failure. Click OK.

P

-

Ternplate Provisicning @

:] Mew SIP Trunk created successfully using selected ternplate.
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The newly created SIP Line will appear in the Navigation pane (e.g., SIP Line 17).

=& BOOTP (8)
4% Operator (3)
-5 Solution

w-§  User(56)

!a Group(2)

-9 Short Code(48)
----- am Directory(0)
-7 Time Profile(0)
----- B8 Account Code(0)
-§5 User Rights(9)
(-85 Location(l)

== IPOSE-Primary

[H-5%7 System (1]
&-t[Line (3]
Lt " .1

H " 2

= Control Unit (9)

-4 Extension (6)

i User (7]

-l Group (0)

-9 Short Code (2)

""" @ Service (0]

@ Incoming Call Route (2)
- Jill IP Route (3)

W License (33)
- ARS (1)
(-8 Location (1)
-5 Authorization Code (D)
-2y [P500V2-One

(423 [P500V2-Two

It is important that the SIP Line configuration be reviewed and updated if necessary, after the
SIP Line is created via the template. The resulting SIP Line data can be verified against the
manual configuration shown in Sections 5.4.2 to 5.4.7.
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5.4.2. SIP Line = SIP Line Tab

On the SIP Line tab in the Details pane, configure or verify the parameters as shown below:

e Set ITSP Domain Name to clearcom.mx, the domain name provided by Clearcom.

e Verify that In Service box is checked, the default value. This makes the trunk available
to incoming and outgoing calls.

e Verify that Check OOS box is checked, the default value. IP Office will use the SIP
OPTIONS method to periodically check the SIP Line.

e Verify that Refresh Method is set to Auto.

e Verify that Timer (sec) is set to On Demand.

e For the compliance test REFER support was disabled. Thus, Incoming Supervised
REFER and Outgoing Supervised REFER should be set to Never. Refer to Sections
2.1 and 2.2 for the reason this field was disabled.
Click OK to commit (not shown).

Configuration |

i= SIP Line - Line 17

B

Il
(&)

BOOTP (8)

% Operator (3)

=7 Solution

B-§  User(36)
(-5 Group(2)
(-8 Short Code(48)

Directory(0)

! Time Profile(0)
Account Code(0)
-3 User Rights(3)

- Location
(=)-*%=2|IPOSE-Primary

vy, 2

Loy .

[+~ Control Unit (9)
48 Extension (6)
G- User (7)

..... u Group (0)
@M Short Code (2)

----- @ Service (0)

E]---@ Incoming Call Route (
(-l IP Route (3)

----- e License (33)

- ARS (1)

(- Location (1)

----- &% Authorization Code (0

[r-453 IP500V2-One
[-453 IP500V2-Two

SIP LiﬂelTransportliall DetailsIVoIP |SIP CredentialslSIP AdvancedlEngineering|

Line Mumber 17 =

|1TSP Domain Name clearcom.mx

Local Domain Name

In Service

Check 005

URI Type B

Location ’CIoud

Prefix
MNational Prefix
International Prefix

Country Code

MNarne Priority Systern Default

Description Service Provider

Session Timers

Refresh Method

Timer (sec)

Auto

On Dernand

Redirect and Transfer

Incoming Supervised REFER

Outgoing Supervised REFER

’Never

’Never

Send 302 Moved Temporarily
Outgoing Blind REFER

O
0
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5.4.3. SIP Line - Transport Tab

Select the Transport tab. Set or verify the parameters as shown below:

e Leave the ITSP Proxy Address blank (IP Office will retrieve the ITSP Proxy Address
via public DNS queries using the ISTP Domain Name provided under in Section 5.4.2).
The public DNS IP addresses were configured under Section 5.2.2.

Set Layer 4 Protocol to TLS.

Set Use Network Topology Info to None (refer to the note below).
Set the Send Port and Listen Port to 5061.

Default values may be used for all other parameters.

Click OK to commit (not shown).

Configuration ‘ = SIP Line - Line 17

#-R BOOTP (2 SIP Line] Transport|Call Details VolP  SIP Credentials SIP Advanced Engineering
+-¢# Operator (3]
=I-*=2 Solution ITSP Proxy Address | |
=-§  User(36)
+ﬂ Group(2)
+1-8% Short Code(48)

Metwork Configuration

----- @m Directory(0) Layer 4 Protocol TLS w Send Port | 3061
----- 1% Time Profile(0)
..... & Account Code(0) Use Metwork Topology Infe | Mone ~ Listen Port 3061
+-§q User Rights(g)
+|§ L.:.caticmg'lJ Explicit DNS Server(s) 0 0 0 0 0 0 0 0
=433 IPOSE-Primary

-5 Systern (1) Calls Route via Registrar

17 Line (3)
P T

2 Separate Registrar |

+ = Control Unit (9)

+-4f Extension (6]

@ User (7)

--iaf Group (0)

+-@% Short Code (2]

4B Service (0)

+e Incoming Call Route (2)
+n IP Route (3)

Q; License (33)

+( ARS (1)

+IE Location (1)

ﬁ Authorization Code (0)
%59 |P500V2-One

+-559 [PS00Y2-Two

Note — For the compliance testing, the Use Network Topology Info field was set to None,
since no NAT was used in the test configuration. If a NAT is used between Avaya IP Office
and the other end of the trunk, then the Use Network Topology Info field should be set to the
LAN interface (LAN1 or LANZ2) used by the trunk and the System = LANL1 (or 2) =
Network Topology tab needs to be configured with the details of the NAT device.
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5.4.4. SIP Line — SIP Credentials Tab

Select the SIP Credentials tab, and then click the Add button to add the SIP Trunk registration
credentials. Set the parameters as show below:

e For User name, enter the user name credential provided by Clearcom for SIP Trunk
registration.

e For Authentication Name, enter the authentication name credential provided by
Clearcom for SIP Trunk registration. For the compliance test the same value used under
User Name was used.

e Leave the Contact blank.

e For Password and Confirm Password, add the password credential provided by
Clearcom for SIP Trunk registration.

e Set Expiry (mins) to a value acceptable to the enterprise. This setting defines how often
registration with Clearcom is required following any previous registration. For the
compliance test 30 minutes was used. This value should be chosen in consultation with
the service provider.

e Verify that Registration required is checked.

e Click the OK to commit (not shown).

Configuration = SIP Line - Line 17
8 BOOTP (&) |SIP LinelTransporthalI DetailslVoIP |SIP Credentials |SIP AdvancedlEngineering|
g Operator (3)
=29 Solution Index User Name Authentication Name Contact Expiration (mins) Register
D"I User(56) 1 userl23 userl23 30 True
-5 Group(2)
[=--@% Short Code(48)
----- s Directory(0)
----- 1% Time Profile(0)
----- #m Account Code()
#-§y User Rights(3)
-3 Location
---*-':H Systemn (1)
- 1[ne 6]
..... 1‘ .1
..... wy, 2
Ly
(= Control Unit (3]
-4 Extension (5)
@ User(7)
----- ﬂ Group (0)
8% Short Code (2) Edit SIP Credentials
""" @ Service (0] User name userl?3
EJ---@ Incorning Call Route (
=-§ll IP Route (3) Authentication Name userl23
----- % License (33)
- ARS (1) Contact
- Location (1)
----- 28 Authorization Code (0 Password sreetuetaese
(%52 IP500V2-One Confirm Password (ILLTTT I L]
[#-4=p IP500V2-Two
Expiration (mins) 30 =
Registration required
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5.4.5. SIP Line — Call Details Tab

Select the Call Details tab, and then click the Add... button (not shown) and the screen shown
below will appear. To edit an existing entry, click an entry in the list at the top, and click the
Edit... button. In the example screen below two new entries were added, one for incoming calls
and one for outgoing calls.

The entry for calls from IP Office to the PSTN (outgoing calls) was created with the parameters
shown below:

e Associate this entry to an outgoing line group using the Outgoing Group field. The
outgoing line group number is used in defining short codes for routing outbound traffic
from this line. For the compliance test outgoing group 17 was used. Leave the Incoming
Group field as 0.

e Under Credentials, select 1: user123 from the pull-down menu (this field will default to
the User Name used under the SIP Credentials tab in Section 5.4.4).

e Set Max Sessions to the number of simultaneous SIP calls that are allowed using this SIP
URI pattern.

e Check the P Asserted ID and Diversion Header.

e Set the Local URI, Contact, P Asserted ID and Diversion Header fields to the values
shown in the screenshot below. Note that the user name used under SIP Credential
(Section 5.4.4) was used under the Display and Content columns for Local URI, this
setting is needed since Clearcom required the user name to be sent in the “From” header
of SIP INVITE messages.

e Set all remaining fields as shown on the screenshot below.

e Click OK.

New URI

Incoming Group *  Max Sessions 1o

Outgoing Group 17 -

Display Content Field meaning
Outgoing Calls Ferwarding/ Twinning Incoming Calls

Local URI userl23 + userlZ3 - [Explim ,] [Emlidt v] [Explidt ,]
Contact Use Intemal Data » Use Intemal Data - [Cal\er ,] [Onginal Caller ,] [Called ,]
P Asserted ID Use Intemal Data ~ Use Intemal Data - [[_‘al\er ,] [Onglnal Caller ,] [Ealled ,]
PPrefered ID  [C] |None None None None None

Diversion Header Use Intemal Data + Use Intemal Data - [None ,] [Caller _] [None ,]
Remote Party 1D [] |Mone None None Mone None

[ QK ] I Cancel ] I Help ]
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The entry for calls from the PSTN to IP Office (incoming calls) was created with the parameters
shown below:

Associate this entry to an incoming line group using the Incoming Group field. For the
compliance test incoming group 17 was used. The Outgoing Group field was set to 100,
since it cannot be set to 0 in IP Office Server Edition systems, this is an arbitrary number.

Set the Credentials field to 0: <None.

Set Max Sessions to the number of simultaneous SIP calls that are allowed using this SIP
URI pattern.

For the Local URI and Contact, set the selections under the Display and Content
columns to Auto.

Set all remaining fields as shown on the screenshot below.

Click OK.
Click OK to commit again (not shown).

New URI

Incoming Group 17 v  Max Sessions fo

Outgoing Group 100 -

.

Display Content Field meaning
Outgoing Calls Forwarding/ Twinning Incoming Calls

Local URI Auto v uto v [cater ~ | [onginal Caler ~ | [caled -]

Contact Auto v Ao v [caller ~ | [original Caler -] [caled -

F Asserted D [ [Mone None None None None

P Prefered ID  [C] |More None None Mone None

Diversion Header [C] |Mone None None None Mone

Remote Party D[] |Nore Mane None None None

I QK ] ’ Cancel I ’ Help ]

HG; Reviewed: Solution & Interoperability Test Lab Application Notes 31 of 56

SPOC 6/24/2020 ©2020 Avaya Inc. All Rights Reserved. CTLSIPO1104




5.4.6. SIP Line - VoIP Tab

Select the Vol P tab, to set the Voice over Internet Protocol parameters of the SIP Line. Set or
verify the parameters as shown below:

e The Codec Selection was configured using the Custom option, allowing an explicit
order of codecs to be specified for the SIP Line. The buttons allow setting the specific
order of preference for the codecs to be used on the SIP Line, as shown. Clearcom
supports codecs G.729(a), G.711ALAW and G.711ULAW for audio.

e Select None for Fax Transport Support (refer to Section 2.2).

e Setthe DTMF Support field to RFC2833/RFC4733. This directs Avaya IP Office to
send DTMF tones using RTP events messages as defined in RFC2833.

e Set the Media Security field to Same as System (Preferred).

e Check the Re-invite Supported box.

e Check the PRACK/100rel Supported box.

e Default values may be used for all other parameters.

e Click the OK to commit (not shown).

£ Time Profile(0)
-l Account Code(0)
f--ﬁ‘, User Rights(9)
+iﬁ Location(1)

-

+--<= Control Unit ()

+€> Extension (8]

g User (7)

ik Group (0)

4@ Short Code (2)

4B Service (0)

+® Incoming Call Route (2]
+-[ill IP Route (3)

B License (33)

W ARS (1)

- Location (1)

ﬂ Authorization Code (0)
4437 [P500V2-One

-4 [P500V2-Two

Unused

Selected

(.729(a) 8K C5-ACELP
G711 ALAW 64K
G711 ULAW 64K

DTMF Support

Media Security

Fax Transport Support | None

RFC2833/RFC4733

Same as System (Preferred)

Advanced Media Security Options

Same As System

RTP
RTCP
RTP

RTCP

Configuration | = SIP Line - Line 17

f"“ BOOTP (2) SIP Line Transport Call Details SIP Credentials SIP Advanced Engineering

4% Operator (3)

=59 Solution [ Local Hold Music
4§ User(sg) —
+% Group(2) Re-invite Supported
+-@% Short Code(48) Codec Selection Custom b [ Codec Lockdown

- Directory(0)

[ Allow Direct Media Path

Force direct media with phones

PRACK/100rel Supported

Note: The codec selections defined under this section are the codecs selected for the SIP Line
(Trunk). The codec selections defined under Section 5.2.4.1 are the codecs selected for the IP

phones/extension (H.323 and SIP).
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5.4.7. SIP Line — SIP Advanced Tab

In the Addressing area:
e Select To Header for Call Routing Method.

In the Identity area:

e Check the box for Use PAI for Privacy.
e Click OK to commit (not shown).

B-557 [PS00V2-Two

Add UUT header to redirected
calls

Configuration 7 SIP Line - Line 17* £ -
K B00TP @) ‘SIP LinelTransporthaII DatailslVoIP |SIP Credentials| SIP Advanced |Engineermg|
¢ Operator (3)
=% Solution Addressing Media
B User56) Allow Empty INVITE O
[ a Group(2) Association Method [By Source IP address ow Empty
F-@% Short Code(48) Send Empty re-INVITE [}
-8 Directory(0) Allow To Tag Change [
A Ti i Call Routing Method To Header -
-l Account Code(0) -rary-hedia suppo ane
@-fiy User Rights(9) Use P-Called-Party o Send SilenceSupp=0ff |
A5 Location(1)
=% [IPOSE-Primary Suppress DNS SRV Lookups [}
Media Connection Disabled
-+ Line B) Preservation
. é 1 Identity Indicate HOLD &
gy, 2 Use "phone-context” [}
'\ Add user=phone 0
-2 Control Unit (9) Call Control
G- Bxtension (6) Use + for International [
B-§ User () | Use PAI for Privacy I Call Initiation Timeout (s) 4 =
ﬂ Group (0) Use Domain for PAI I} Call Queuing Timeout (mins) |3 =
[+~ 8% Short Code (2)
Caller ID from From header 0 X
@ Service (0) Service Busy Response 486 - Busy Here
(-4 Incoming Call Route ( Send From In Clear |
-l IP Route (3) Cache Auth Credentials on No User Responding Send | 408-Request Timeout
W License (33)
- ARS (1) User-Agent and Server Headers Action on CAC Location Limit | Allow Voicemail
o-& Lo(atio.n U.') Send Location Info [Never ~ Suppress Q850 Reason
M Authorization Code (0 Header [
-5 IP500V2-One Add UUT header ]

Ernulate NOTIFY for REFER [
Mo REFER if using Diversion [
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5.5. Users

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP
Line defined in Section 5.4. To configure these settings, first navigate to User - Name in the
Navigation Pane where Name is the name of the user to be modified. In the example below, the
name of the user is Ext3041 H323. Select the SIP tab in the Details Pane. The SIP Name and
Contact are set to one of the DID numbers assigned to the enterprise by Clearcom. Notice the
DID number shown is preceded with 52, Mexico’s country code. During the compliance test the
DID number in the “To” header of SIP INVITE messages received from Clearcom were
preceded with 52. The SIP Display Name (Alias) parameter can optionally be configured with a
descriptive name. If all calls involving this user and a SIP Line should be considered private,
then the Anonymous box may be checked to withhold the user’s information from the network.
This can also be accomplished by activating Withhold Number on H.323 Deskphones (not
shown). Click the OK to commit (not shown).

Configuration ‘ = Ext3041 H323: 3041

#-R B0OTP 2 Button P ing MenuP ing Mobility Group Membership A ts | SIP
-i—---:,;- Operatgr(}) utton Frogramiming ENu Fragramming (o] IIt}‘ roup EMIDErSNIp ANCURCEMER 5
=% Solution SIP Name |52552881594'I |

H-§  User(36)

138 Group(2) SIP Display Name (Alias) |Ext3041 H323 |

+1-@% Short Code43)

..o Directory(0) Contact (525528815941 |

----- £ Time Profile(0)
----- il Account Code(l) O Ancnymous
1§15 User Rights(9)
+-i Location(1)
+-F System
=7 Line (3)
+-2r Control Unit (9)
+-4 Extension (6)
o4
~-grg Mollser
§= 3050 3050
§ 3040 B3040 H323
i
§ 3042 Bxt3042 H3Z23
e 3047 Ext3047 SIPSoft
e 3051 Ext3051 Deskpho
----- 3% Group (0)
+-@¥% Short Code (2)
4B Service (0)
+-§P Incoming Call Route (2)
+-Jill IP Route (3)
-~ License (33)
- ARS (1)
+- &% Location (1)
-8 Authorization Code (0)
#5357 IP500V2-One
-7 [P500V2-Two
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5.6. IP Office Line — Primary Server

In IP Office Server Edition systems, IP Office Lines are automatically created on each server
when a Secondary server or Expansion System is added to the solution. To edit an existing IP
Office Line, select Line in the Navigation pane, and select the appropriate line to be configured
in the Group pane. The screen below shows the IP Office Line to the IP500V2-One Expansion

System.

Configuration

IP Office Line - Line 1

=K BOOTP (8)

(¢ Operator (3)
E-4%9 Solution

B User(56)
(-5 Group(2)
[+-@% Short Code(48)
----- a5 Directory(0)
-7 Time Profile(0)

3 Account Code(D)
(-5 User Rights(d)
£ Location
E_] +,

[#-=r Control Unit (3)
(-4 Extension (B)
-§  User@

..... “ Group (0)
(@M Short Code (2)
----- @ Service (0)

(- Jilll IP Route (3)
----- % License (33)
[ ARS (1)

(- Location (1)

[r-457 IP500V2-One
[H-553 IP500V2-Two

Line _|Short Codes|VolP Settings|

E]---@ Incoming Call Route (2)

----- @ Authorization Code (0)

Line Number
Transport Type
MNetworking Level

Security

Gateway

Address
Location
Password

Confirm Password

Description

1

’WebSocket Server

[scn

’Medium

192 168 128

165

3: Thornton, CO

7]

Telephone Number

COutgoing Group ID
MNurnber of Channels

Outgoing Channels

SCN Resiliency Options

[] Supports Resiliency
[C] Backs up my IP phones
[C] Backs up my hunt groups
[T Backs up my voicemail

[T Backs up my IP DECT phones

99099
250 =
250 =
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The screen below shows the IP Office Line, VolIP Settings tab:

e Under Codec Selection verify System Default is selected (default value).

e Select None for Fax Transport Support (refer to Section 2.2).
e Under Media Security verify Same as System (Preferred) is selected (default value).

Configuration | ;

IP Office Line - Line 1

£
£
£

£
£

£

=& BOOTP (8)
[-¢% Operator (3)
B3 Solution

H-§  User(56)

H--i@ Group(2)

- 8% Short Code(48)
----- a4 Directory(0)
£ Time Profile(0)
----- @8 Account Code(0)
H-§3 User Rights(d)

-5 Location
-2 [IPOSE-Primary

(%57 System (1)

(-2 Control Unit (9)
(-4 Extension (6)

G-§  User(@)

..... a Group (0)

(8% Short Code (2)

----- @ Service (0]

(43 Incoming Call Route (
(-Jiill IP Route (3)

----- % License (33)

- ARS (1)

(-5 Location (1)

----- 2% Authorization Code (0
H-427 [P500V2-One

£

H-%29 JP500V2-Two

[Line [short Codes| VoIP Settings |

Media Security

Codec Selection ’System Default | v]
e G.711 ULAW 64K
G.711 ALAW 64K
G.729(a) 8K CS-ACELP
cax
E
Fax Transport Support ’None
Call Initiation Timeout (s) |4 =

’Same as System (Preferred)

Advanced Media Security Options

Same As System

RTP
RTCP
RTP

RTCP

Out Of Band DTMF

Allow Direct Media Path

Repeat this process as needed to add additional Secondary server or Expansion Systems to the
solution.
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5.7. Incoming Call Route

Incoming call routes map inbound DID numbers on a specific line to internal extensions, hunt
groups, short codes, etc., within the IP Office system. To add an incoming call route, right click
on Incoming Call Route in the Navigation pane and select New (not shown). On the Details
Pane, under the Standard tab, set the parameters as show below:

e Set Bearer Capacity to Any Voice.

e The Line Group ID is set to 17. This matches the Incoming Group field configured in
the Call Details tab for the SIP Line on Section 5.4.5.

e On the Incoming Number, enter one of the DID numbers provided by Clearcom. Notice
the DID number shown is preceded with 52, Mexico’s country code. During the
compliance test the DID number in the “To” header of SIP INVITE messages received
from Clearcom were preceded with 52.

e Default values may be used for all other parameters.

e Click OK to commit (not shown).

"

Configuration | = 17 525528815941

+l{ BOOTP (2) Voice Recerding  Destinations

#-¢% Operator (3)
=53 Solutien
+-§  User(36)
+§ Group(2)
+-B% Short Code(48) Line Group ID [17 v]
-am Directory(0)
-7 Tirme Profile(0) Incoming Number |52552331 5841 |
-l Account Code(0) | |

Bearer Capability Any Voice ~

41§ User Rights(9) e

+ﬁ Location(1) Incoming CLI |
=153 | IPOSE-Primary i
5% System (1)
+T", Line (3}

+ = Control Unit (9] Priority — -
+-4 Extension (£)

@ User (7) " | |

o ﬂ Group (0)
N Shart Code (2) Hold Music Source Systemn Source ~
B Service (0)

Qg Incoming Call Route (2)
211117 525528815941

b 17 525528815942

=-Jill IP Route (3)

----- e License (33)
- ARS (1)
+ﬁ Location (1)

L488 Authorization Code (0)
#1559 IPS00VZ-One
1457 |P500V2-Two

Locale -

Ring Tene Override |None v|
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Select the Destinations tab. From the Destination drop-down menu, select the IP Office
extension associated with this DID number. In the reference configuration, the DID number
525528815941 provided by Clearcom was associated with the Avaya IP Office extension 3041.

(-3¢ Group(2)

[#-@% Short Code(48)

----- 2 Directory(0)

£ Time Profile(0)

----- @8 Account Code(0)
(-fig User Rights(9)
-8 Location(1)
[#-557 Systern (1)
-7 Line (3)

(= Control Unit (9)
-4 Extension (6)
w-§  User (7)

..... ¢ Group (0)
(8% Short Code (2)

i 17 5528815042
(-Jill IP Route (3)

----- % License (33)

G- ARS (1)

-5 Location (1)

[#-%5p IP500V2-One
(#5557 IP500V2-Two

----- m Authorization Code (0)

Configuration | e 17 5528815941
a BOOTP @) | Standard | Voice Recording| Destinations
“ Operator (3)
-3 Solution TimeProfile Destination Fallback Extension
E-§  User(56) b |Defauit Value 3041 Ext3041 H323 B

Repeat this process as needed to assign incoming call routes to additional IP Office users, as well
as for other Avaya IP Office destinations (Hunt Group, Voicemail, Short Codes, etc.).
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5.8. Outbound Call Routing

For outbound call routing, a combination of system short codes and Automatic Route Selection
(ARS) entries are used. With ARS, features like time-based routing criteria and alternate routing
can be specified so that a call can re-route automatically if the primary route or outgoing line
group is not available. While detailed coverage of ARS is beyond the scope of these Application
Notes, and alternate routing was not used in the reference configuration, this section includes
some basic screen illustrations of the ARS settings used during the compliance testing.

5.8.1. Short Codes and Automatic Route Selection

To create a short code to be used for ARS, right-click on Short Code, the Navigation pane and
select New. The screen below shows the short code 9N created (note that the semi-colon is not
used here). In this case, when the IP Office user dials 9 plus any number N, instead of being
directed to a specific Line Group ID, the call is directed to Line Group 50: Main, which is
configurable via ARS.
e Inthe Code field, enter the dial string which will trigger this short code. In this case, 9N
was used (note that the semi-colon is not used here).
e Set Feature to Dial. This is the action that the short code will perform.
e Set Telephone Number to N. The value N represents the number dialed by the user after
removing the 9 prefix. This value is passed to ARS.
e Setthe Line Group ID to 50: Main to be directed to Line Group 50: Main, this is
configurable via ARS.
e For Locale, Mexico (Latin Spanish) was used.
e Click the OK to commit (not shown).

Configuration | T 9N: Dial*

=R BOOTP @) Short Code
E-¢# Operator (3)
=527 Solution Code aN

-f  User(56)

[ u Group(2) Feature Dial

(8% Short Code(d8)

- Directory(0) Telephone Mumber N

£ Time Profile(0)
-l Account Code(0)
-3 User Rights(9) Locale Mexico (Latin Spanish)
-8 Location(1) [ pe

..... ={ IPOSE-Primary Force Account Code I}

]"L.‘_'J System (1) Force Authorization Code [7]
H-F4 Line (3)

[
[
(-2 Control Unit (3)
[
[

Line Group ID 50: Main

m-E-F

H-4f Extension (6)
i@ User (@)
ﬂ Group (0
=1-8% [Short Code (2)

IR G NE

. gdoN |

= @ Service (0)
(-3 Incoming Call Route (3)
-l IP Route ()
- License (33)
(- ARS (L)
(-5 Location (1)
“ Authorization Code (0)
(-5 IP500V2-One
(-5 IP500V2-Two
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The following screen shows the example ARS configuration for the route Main. Note the
sequence of Xs used in the Code column of the entries to specify the exact number of digits to be
expected, following the access code and the first set of digits on the string. This type of setting
results in a much quicker response in the delivery of the call by IP Office.

To create a short code to be used for ARS, select ARS - 50: Main on the Navigation Pane and
click Add (not shown). Configure the following parameters:
¢ Inthe Code field, enter the dial string which will trigger this short code. In this case, 001
followed by 10 Xs to represent the exact number of digits.
e Set Feature to Dial. This is the action that the short code will perform.
e Set Telephone Number to 001N. The value N represents the additional number of digits
dialed by the user after dialing 001 (The 9 will be stripped off).

e Setthe Line Group Id to the Line Group number being used for the SIP Line, in this
case Line Group ID 17 was used.

e For Locale, Mexico (Latin Spanish) was used
e Click OK to commit.

The following example shows the dial pattern for calls to the United States.

Edit Short Code

Code DO1XO0CCON0K
Feature Dial -

Telephone Number 001N

Line Group 1D 17 -

Locale [Mexico (Latin Spanish) -

Force Account Code =]

Force Authorization Code [

The following example shows the dial pattern for local calls within Mexico.

Edit Short Code

Code B1IOO0000X
Feature Diial -

Telephone Number 81N

Line Group 1D 17 -

Locale [Mexicu (Latin Spanish) -

Force Account Code Ol

Force Authorization Code [

HG; Reviewed: Solution & Interoperability Test Lab Application Notes 40 of 56
SPOC 6/24/2020 ©2020 Avaya Inc. All Rights Reserved. CTLSIPO1104



Repeat the above procedure for additional dial patterns to be used by the enterprise to dial out
from IP Office.

5.9. Save IP Office Primary Server Configuration

The provisioning changes made in Avaya IP Office Manager must be applied to the Avaya IP
Office server in order for the changes to take effect. At the top of the Avaya IP Office Manager
page, click File = Save Configuration (if that option is grayed out, no changes are pending).

A screen similar to the one below will appear, with either Merge or Reboot automatically
selected, based on the nature of the configuration changes. The Merge option will save the
configuration change with no impact to the current system operation. The Immediate option will
save the configuration and cause the Avaya IP Office server to reboot.

Click OK to execute the save.

| Send Multiple Configurations EI@
Select . Change . Incoming Qutgoing Error
IP Office Maode RebootTime Call Barring Call Barring Status Progress
» IPOSE-Primary 2:21 PM W W Q |
[ oK l l Cancel ] ’ Help
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6. Avaya IP Office Expansion System Configuration

Navigate to File > Open Configuration (not shown), select the proper Avaya IP Office system
from the pop-up window, and log in using the appropriate credentials. Clicking the “plus” sign
next to IP Office Expansion system, in this case IP500V2-One was selected.

Configuration 5 System Inventory
=& BOOTP (@)
-4 Operator (3) Server Edition Expansion System

E-%%2 Solution

EH-§  User(S6)
Eﬂ---ﬂ Group(2) = Hardware Installed
-8 Short Code(48) Control Unit: IP 500 V2
-4 Directory(D) Internal Modules: VCME4/PRID U, PHONES
-1 Time Profile(0) Expansion Modules: DIG DCPx16 V2
-~ Account Code(0) o System Settings
=-§i§ UserRights() IP Address: 192.168.128.165
gﬁ ILPUC‘J;E_”;&AE Sub-Net Mask: 255255 265.0
El""““J System Locale: United States (US English)
-5 System (L) System Location: 3: Thornton, CO
F-F7 Line (3) Drevice ID; NOME
-2 Control Unit (4) Mumber of Extensions on System: 24
-4 Extension (24) = Features Configured
E-§  User (27) Licenses Installed: Server Edition(1)
=38 Group (1) Connected Extensions: 3043; 3044
E]E z::igge (12) Users NOT Configured for Voicemail: NONE
-, RAS (1) Users assigned as Ex-Directory: NOMNE
D,_e Incoming Call Route (2) Users assigned for Twinning: NOME
..... @ WAN Port (0) Users barred from making Outgoing Calls: MOME
-8} Firewall Profile (1) Music on Hold: WAV File
--Jilll IP Route (4)
----- % License (1)
----- @& Tunnel (0)
- ARS (2)
[ Location (1)
----- a Authonzation Code (0}
[#--=p IPS00VZ-Two
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6.1. Physical Hardware

In the sample configuration, the IP500 V2 Expansion System contained a PHONES analog card,
for the support of analog extensions, a DIG DCPx16 V2, for support of digital extensions. Also
included is a VCM64 (Voice Compression Module). The VCM64 cards provide voice
compression channels to the control unit. VVoice compression channels are needed to support

VolIP calls, including IP extensions and or IP trunks.

Configuration

x

IP 500 V2

=- K BOOTP (8)

B¢ Operator (3)

E"-’-_w Solution

i@ User(S6)

-8 Group(2)

@M% Short Code(48)

- Directory(0)

-7 Tirme Profile(0)

-l Account Code(0)

§5 User Rights(9)

-f@ Location(l)

-#=) IPOSE-Prima
---"-w System (1)
-1 Line (3]

= | Control Unit (4)

i1 2 VCMB4/PRID U

1= 3 PHONES

1“2 6 DIG DCPx16 V2
H-48 Extension (24)

:lﬂ User (27)

-4 Group (1)

H-@% Short Code (12)

- GBY Service (0)

- RAS (1)

EEI---@ Incoming Call Route (2)
-8 WAN Port (0)

B8} Firewall Profile (1)
&-Jill 1P Route (4)

% License (1)

- Tunnel (0}

- ARS (2)

-5 Location (1)

-8 Authorization Code (0)
[H-*%%3 IP5S00V2-Two

Unit

Device Mumber

Unit Type

Version

Serial Number

Unit IP Address
Interconnect Mumber

Module Mumber

11.0.4.1.0 build 11

192168128165
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6.2.

LAN Settings

In the sample configuration, LAN1 is used to connect the Expansion System to the enterprise
network. To view or configure the LAN1 IP address, select System on the Navigation pane.
Select the LAN1 - LAN Settings tab on the Details pane, and enter the following:

IP Address: 192.168.128.165 was used in the reference configuration.

IP Mask: 255.255.255.0 was used in the reference configuration
Click the OK button (not shown).

Configuration

i
i
i

IP500V2-One

=- R BOOTP (8)

E-¢% Operator (3]

=27 Solution

@ User(58)

-5 Group(2)

[-8% Short Codef48)
----- s Directory(0)

----- 1 Time Profile(0)
----- B Account Code(0)
E-f5 User Rights(g)
- Location(1)
[#-5=p IPOSE-Primary
=-#=3[IP500V2-One

= “=F Systern (1)
-39 [PS00V2-One

F-T9 Line (3)

(-2 Control Unit (4)
- Extension (24)
B-§  User (27)
[-i§ Group (1)
8% Short Code (12)
E Service (0]

[ oy RAS (1)

-~ EE} WAN Port (0]
(-8 Firewall Profile (1)
i-Jill IP Route (4)

B License (1)

- Tunnel (0)

- g ARS (2)

[~ Location (1)

[+--5=3 IPS00V2-Two

- Incoming Call Route (2)

ﬁ Authorization Code (0)

LAMZ | DMS | Voicemail | Telephony | Directory Services | System Events

| System | LANIL
LAN Settings |VoIP | NetworkTopology|
IP Address 192 168 128 165
IP Mask 255 255 255 ]
Primary Trans. IP Address 0 0 0 0
RIP Mode [None
[C] Enable NAT
Number Of DHCP IP Addresses | 200 &
DHCP Mode
) Server () Client ) Dialln @ Disabled

Default values were used on the VolP and Network Topology tabs (not shown).
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6.3. IP Route
To create an IP route for the Expansion system, right-click on IP Route on the left Navigation
pane. Select New (not shown).
e Enter 0.0.0.0 on the IP Address and IP Mask fields to make this the default route.
e Set Gateway IP Address to the IP Address of the default router in the IP Office subnet.

The default gateway in the reference configuration was 192.168.128.200
e Set Destination to LAN1 from the pull-down menu.

Configuration

B

R BOOTP (8)
i« Operator (3)

%2 Solution

E-§ User31)
-5§ Group(l)
[-8% Short Code(47)
----- & Directory(0)
----- £9 Tirme Profile(0)
----- Bl Account Code(D)
[El---;-i User Rights(3)
5@ Location(1)
[#-%%p IPOSE-Prima
£l System (1)
gy IP500-Expansion
&-F7 Line (3)
-2 Control Unit (4)
-y Extension (24)
H-§  User 27)
ﬂ- Group (1)
[-@% Short Code (12)
@ Service (0)
oy RAS (1)
e Incoming Call Route (2)
~¥F WAN Port (0)
@ Firewall Profile (1)
Bl il IP Route (4)
4L J0000]
; 10641010
----- Bl 192.168.128.0
-l 192.168.99.0
----- % License (1)
----- @ Tunnel (0)
E- ARS (2)
(-5 Location (1)
----- m Authorization Code (0)

IP Route

IP Address 0 0 0 0
IP Mask 0 0 0 0
Gateway IP Address 192 168 138 200
Destination | LANL
Metric 0

[T] Proxy ARP
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6.4. IP Office Line — IP500 V2 Expansion System

In IP Office Server Edition systems, IP Office Lines are automatically created on each server
when a Secondary server or Expansion System is added to the solution. To edit an existing IP
Office Line, select Line in the Navigation pane, and select the appropriate line to be configured
in the Group pane. The screen below shows the IP Office Line to the Primary server.

Configuration

| "

IP Office Line - Line 17

=& BOOTP (8)

[-¢% Operator (3)
-3 Solution

E-§  User(56)
[-if Group(2)
(8% Short Code(48)
----- 2 Directory(0)
£ Time Profile(0)
----- 8 Account Code(0)
H-fi5 User Rights(9)
- Location(1)

t-#27 Systern (1)
'

1

(-2 Control Unit (4)
(-4 Extension (24)
@ User (27)
(- Group (1)
(-8 Short Code (12)

ol RAS (1)

----- £8 WAN Port (0)
(-4} Firewall Profile (1)
&l IP Route (4)

----- % License (1)

""" % Tunnel (0)

- ARS (2)

(-8 Location (1)

-39 IP500V2-Two

E]---@ Incoming Call Route (2)

----- m Authorization Code (0)

Line  [Short Codes|VoIP Settings| 738 Fa

Line Mumber
Transport Type
Networking Level

Security

Gateway

Address
Location
Password

Confirm Password

Description

17 5 Telephone Number
[WebSocket Client <] prefix
’SCN v] | Outgoing Group ID 99999
’Medium v] Number of Channels 250 5
Outgoing Channels 250 5
10 64 101 127 Port 443 5

3: Thornton, CO

v] SCN Resiliency Options

[[] Supports Resiliency

[C] Backs up my IP phones

[C] Backs up my hunt groups

[ Backs up my IP DECT phones
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The screen below shows the IP Office Line, VolIP Settings tab:

e Under Codec Selection verify System Default is selected (default value).

e Select None for Fax Transport Support (refer to Section 2.2).
e Under Media Security Preferred was selected.

Configuration

= IP Office Line - Line 17

g%

i e W]

m

=& BOOTP (8)
-4 Operator (3)

=7 Solution

@@ User(36)

(-3¢ Group(2)
[-8% Short Code(48)

a4 Directory(0)

-£1% Time Profile(0)

-l Account Code(0)
£ User Rights(3)
&5 Location(l)

]..
H-439 IPOSE-Prima

[

(-2 Control Unit (4)
-4 Extension (24)
@@ User (27)
(-5 Group (1)
(8% Short Code (12)

ol RAS (1)

(- Incoming Call Route (2)
----- £ WAN Port (0)

#-@ Firewall Profile (1)
(-l IP Route (4)

----- % License (1)

""" & Tunnel (0)

@i ARS (2)

-8 Location (1)

----- ﬂ Authorization Code (0)

£

H-%39 [P500V2-Two

[tine [short Codes] VolP Settings|T38 Far]

Codec Selection [System Default | ']
RN G.711 ULAW 64K
G.711 ALAW 64K
G.729(a) 8K C5-ACELP
G.723.1 6K3 MP-MLQ
<<
EER
Fax Transport Support [None

Call Initiation Timeout (s} |4 =

Media Security [Preferred

Advanced Media Security Options

64

Same As System

RTP
RTCP
RTP

RTCP

[] VolP Silence Suppression

Out Of Band DTMF

Allow Direct Media Path
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6.5. Short Codes

Similar to the configuration of the Primary server in Section 5.8.1, create a Short Code to access
ARS. In the reference configuration, the Line Group ID is set to the ARS route illustrated in the
next section.

Configuration T 9N: Dial*

- % BOOTP (8) Short Code

‘.ff Operator (3)
=-+457 Solution Code N
B-§  User(S6)
D...a Group(2) Feature Dial
[+--@X Short Code(48)
----- a4 Directory(0)

----- £1 Time Profile(0)
----- #m Account Code(0)
Eja“i User Rights(9) Locale [Mﬂ{ico (Latin Spanish)
[+-5& Location(l)

-3 [POSE-Prima Force Account Code [l
Elmk';“‘ Force Authorization Code  [C]
[H-%=p System (1)
-9 Line (3)

-2 Control Unit (4)
-4 Extension (24)
E-§ User (27)

ﬂ Group
=@ 02N
----- @ Sernvice (0)
[-alfy RAS (1)
- Incoming Call Route (2)
----- ¥8 WAN Port (0)
B8} Firewall Profile (1)
-l IP Route (4)
----- . License (1)
----- % Tunnel (0)
H-"g ARS (2)
(-8 Location (1)
----- m Authorization Code (0)
[ IPS00V2-Two

Telephone Number M

Line Group ID 51: To-Primary
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6.6. Automatic Route Selection — ARS

The following screen shows an example ARS configuration for the route named “To-Primary”
on the Expansion System. The Telephone Number is set to 9N. The Line Group ID is set to

“99999” matching the number of the Outgoing Group ID configured on the IP Office Line 17 to
the Primary server (Section 6.4).

Configuration | = To-Primary

&K BOOTP (8) ARS
- Operator (3)
£33 Solution |ARS Route ID 51 [] Secondary Dial tone
G- User(56)

E a E}zontltpé?ds(dﬂj Route Name To-Primary SystemTone
- Directory(0)
t:,“\ Time Profile(0) Dial Delay Time Systern Default (4) z [] Check User Call Barring
-l Account Code(0)
% E;f;g;gﬂ}}im Description
-#3 IPOSE-Primary
-7 System (1) In Service
1 Line (3) l
+“= Control Unit (4}

-y Extension (24) Time Profile =None>
‘@ User21)
% Group (1) |
X Short Code (12)
4B Service (0) Code Telephone Number Feature Line Group ID
o RAS (1)

-@Incommg Call Route (2) IN 9N Dial 99999
&8 WAN Port (0) Remove
& Firewall Profile (1) -
-l 1P Route (4) Edit...
- License (1)

il Tunnel (0]

- 50: Main

-i@ Location (1)

m Authorization Code (0) l
(-39 [P500V2-Two

-

i}

Out of Service Route I(None) vl

et Qut of Hours Route |<None> vl

[ e [ - o

I

e

-

I

30

o | — Alternate Route l<None> vl

Repeat this process as needed to add additional Secondary server or Expansion Systems to the
solution.
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6.7. Save IP Office Expansion System Configuration

Navigate to File = Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections

The following will appear, with either Merge or Reboot selected, based on the nature of the
configuration changes made since the last save. Note that clicking OK may cause a service
disruption. Click OK to proceed.

"] Send Multiple Configurations EI@
Select ) Change ] Incoming Outgoing Error
IP Office Maode RebootTime Call Barring Call Barring Status Progress
3 IPS00V2-One 4:08 PM & 0 Q |0z
[ OK l l Cancel ] l Help
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7. Clearcom SIP Trunking Service Configuration

To use Clearcom SIP Trunking Service, a customer must request the service from Clearcom
using the established sales processes. The process can be started by contacting Clearcom via the
corporate web site at: http://www.clearcom.mx/ and requesting information.

During the signup process, Clearcom and the customer will discuss details about the preferred
method to be used to connect the customer’s enterprise network to Clearcom network.

Clearcom is responsible for the configuration of Clearcom SIP Trunking Service. The customer
will need to provide the public IP address used to reach the IP Office at the enterprise. In the case
of the compliance test, this is the public IP address of the IP Office WAN port (LAN2) of the
Primary server.

Clearcom will provide the customer the necessary information to configure Avaya IP Office
following the steps discussed in the previous sections, including:

e SIP Trunk registration credentials (User Name, Password, etc.).

e Clearcom Domain Name and SIP Proxy FQDN.

e DID numbers.

e DNS IP addresses.

e Transport Layer Security (TLS) requirements (e.g., TLS certificate requirements).

o Etc.
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8. Verification Steps

This section provides verification steps that may be performed to verify that the solution is
configured properly.

The following steps may be used to verify the configuration:
Verify that endpoints at the enterprise site can place calls to the PSTN.
Verify that endpoints at the enterprise site can receive calls from the PSTN.
Verify that users at the PSTN can end active calls to endpoints at the enterprise by
hanging up.
o Verify that endpoints at the enterprise can end active calls to PSTN users by hanging up.

8.1. IP Office System Status
The following steps can also be used to verify the configuration.

Use the IP Office System Status application to verify the state of SIP connections. Launch the
application from Start - Programs - IP Office = System Status on the PC where IP Office
Manager is installed, log in with the proper credentials.

Avaya IP Dffice System Status [_|

AVAyA IP Office System Status

Help Exit About

Cffline

Logon

Control Unit Address: EELN-ERIEREE

Proxy Server Address: EEIIELEES

Services Base TCP Port: [HEhE

Local IP Address: EANGIGET]

User Name: ELIREE R S1E

Password:

M Auto reconnect

ﬂ Secure connection

B Websocket connection
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Select the SIP line under Trunks from the left pane. On the Status tab in the right pane, verify
the Current State is Idle for each channel.

IP Office System Status

Status  Utilization Summary Alarms  Registration
SIP Trunk Summary
Line Service State: In Service
Peer Domain Mame: clearcom.mx
Resolved Address: .38.168
Line Number: 17
Number of Administered Channels: 20
Number of Channels in Use: 0
Administered Compression: G729 A, G711 A, G711 Mu
Enable Faststart: off
Silence Suppression: Off
Media Stream: Best Effort
Layer 4 Protocol: TLS
SIP Trunk Channel Licenses: 123 . 0%
SIP Trunk Channel Licenses in Use: 0

SIP Device Features:

Time FRemote C... Con... Caller Other Dire... Round Rec... Rec...
in5... Medi.. ID ... Party o... Trip...
Ide |5da... A
Idle |5da...
Ide |7da...
Ide |7da...
Ide |7da...
Ide |7da...
Ide |7da...
Idle |7da...
Ide |7da...
Ide |7da...
Ide |7da...
Ide |7da...
Idle |7da...
Ide |7da...
Ide |7da...
Ide |7da...
Ide |7da...
Ide |7da...

Idle |7da... W
-

%[ 5[k| e B 0| @ <o n| s ]w|m| -

-
[

=

—
=

&

=
1=

Trace Trace Al Pause Ping Call Details Graceful Shutdown Force Qut of Service
Print... Save As...
3:42:51FPM Onling &
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8.2. Monitor

The Avaya IP Office Monitor application can be used to monitor and troubleshoot signaling
messaging on the SIP trunk. Launch the application from Start - Programs - IP Office >
Monitor on the PC where IP Office Manager was installed. Click the Select Unit icon on the
taskbar and Select the IP address of the IP Office system under verification.

Iﬂ_ Avaya IP Office Sys™Monitor - [STOPPED]
File Edit Wwiew Filkers Status Help

=8| ~8|T| x|V = &=

' RN

Start/Stop Trace Select
Trace Options  Unit

Clicking the Trace Options icon on the taskbar, selecting the SIP tab allows modifying the
threshold used for capturing events, types of packets to be captured, filters, etc. Additionally, the
color used to represent the packets in the trace can be customized by right clicking on the type of
packet and selecting the desired color.

All Settings (23]
T1 | wComp | wPM | waW | scw | ssi | Jade |
4TM | cal | DTE | EConf | FrameRelay | GOD | H323 | Intedace |
1SDH | Fev/Lamp | Directomy | Media | PFF | R | Routing | Services SIF |S_l,lstem|
Ewents
W Sip |vebose - I~ STUN I~ SIP Dect
Packets
[~ SIP Reg/Opt Rix [~ SIP Mizc R=
[~ SIPReg/Opt Tx [~ SIP Mizc Tx
[~ SIP Call Rx [ Crn Matify B
[~ SIPCall Tx I~ Crn Motify Tx
v Sip Rx [ hex IF Filter [nnmn.nnn. nnn. pnn)
¥ Sip Tx [~ hex |
D efault AII‘ Clear All ‘ Tab EIearAII‘ Tab Set!—'«ll‘ B | cancel
Sl | Load File | Load Partial File| Select File |
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9. Conclusion

These Application Notes describe the configuration necessary to connect Avaya IP Office
Release 11.0 to Clearcom SIP Trunking Service using TLS. Clearcom SIP Trunking Service is a
SIP-based Voice over IP solution for customers ranging from small businesses to large
enterprises. It provides a flexible, cost-saving alternative to traditional hardwired telephony
trunks.

Interoperability testing was completed successfully with the observations/limitations outlined in
the scope of testing in Section 2.1 as well as under test results in Section 2.2.

10. Additional References

This section references the documentation relevant to these Application Notes. Product
documentation for Avaya IP Office, including the following, is available at:
http://support.avaya.com/

[1] Deploying IP Office Platform Server Edition Solution, Release 11.0, Issue 12, March 2020

[2] IP Office Platform 11.0, Deploying Avaya IP Office Servers as Virtual Machines, Issue 06i,
April 25, 2019

[3] IP Office Platform 11.0, Deploying Avaya IP Office Essential Edition (IP500 V2), Issue 35f,
January 2020.

[4] Administering Avaya IP Office Platform with Manager, Release 11.0, February 2019.

[5] Planning for and Administering Avaya IX ™ Workplace Client for Android, iOS, Mac and
Windows, Release 3.7 Issue 1, October 20109.

Additional Avaya IP Office documentation can be found at: https://ipofficekb.avaya.com/
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full title name and filename, located in the lower right corner, directly to the Avaya
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